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Introduction
Cisco Agent Desktop is a robust computer telephony integration solution that is easy to install, configure,
and manage. It provides agents with powerful tools to increase productivity, reduce operational costs, and
improve customer satisfaction.

Agent Desktop provides call control capabilities (such as call answer, hold, conference, and transfer) and
ACD state control (ready/not ready, wrap up, etc.). Customer information is presented to the agent
through an enterprise data window and an optional screen pop. Agent Desktop requires minimum screen
real estate and enables agents to customize its functionality to meet their individual needs.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthlyWhat’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to theWhat’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a
free service and Cisco currently supports RSS version 2.0.

Documentation Feedback

You can provide comments about this document by sending e-mail to the following address:

ccbu_docfeedback@cisco.com

We appreciate your comments.

Agent Desktop Feature Levels

There are two feature levels in Agent Desktop: Enhanced and Premium.

The following table outlines the features available at each feature level. All features not listed here are
present in both versions.

Feature Standard Enhanced Premium

Agent-initiated call recording x x

Agent-initiated chat x x x

Cisco IP Communicator support x x x

Cisco Unified Mobile Agent support x x x
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Feature Standard Enhanced Premium

Cisco Unified Outbound Dialer x x

Cisco Unified Presence Server integration x x x

Enterprise data thresholds x x x

Event-triggered work flows x x

HTTP Post/Get action x

Integrated browsr with multiple tabs x

IPC Receive action x

Phone book x x

Reason codes x x x

Task buttons x x

Timer action x x

Wrap-up data x x x

CTI OS Record action x x

Cisco IP Communicator

Agent Desktop supports the use of the IP Communicator soft phone. This application is not provided with
Agent Desktop and must be purchased and installed separately.

You must start IP Communicator manually (it does not start automatically when you start Agent Desktop).
To conserve system resources, you might want to keep IP Communicator minimized as much as possible
and use the Agent Desktop interface for call control.

To ensure that IP Communicator does not maximize when a call is received (the default setting) you must
change your preferences as outlined in the following procedure.

Tomake sure IP Communicator remains minimized when a call is received:
1. Start IP Communicator.

2. Right-click anywhere on the interface to display a popup menu, and then choose Preferences. The
Preferences dialog box appears.

3. On the User tab, clear the Bring to front on active call check box (the default setting) and select the
Hide on minimize check box.
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4. Click OK.

Automated Updates

CAD enables your administrator to update all instances of Agent Desktop automatically to a newer version.

Every time you launch Agent Desktop, the software checks to see if there is an updated version available,
or if there was a system configuration change that requires a Windows registry change. If either of these
conditions are true, the software automatically runs the update process.

When the update process runs, a dialog box appears, stating that your copy of Agent Desktop will be
updated. Click OK and then follow the instructions in the series of dialog boxes that follows. After the
update finishes, a final dialog box appears, stating that your update is complete. Click OK, restart Agent
Desktop, and log in as you usually do.

Note: Because Agent Desktop is automatically installed when Supervisor Desktop is installed,
only Supervisor Desktop will be listed as having been updated in the final dialog box. Agent
Desktop will be listed only if Supervisor Desktop is not present on your PC.

Note: To ensure that automated updates function correctly, Internet Explorer must be configured
so that it checks for newer versions of stored pages. In Internet Explorer, choose Tools > Internet
Options. In the Browsing history section on the General tab, click Settings. Select the option
labeled Every time I visit the web page.
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Logging In
You can log in using Agent Desktop as a local agent or as a mobile agent. A local agent uses Agent
Desktop within the contact center. Amobile agent uses Cisco Unified Mobile Agent to connect to Agent
Desktop via any kind of phone (including a cell phone) from outside the contact center.

Multi-line Phones

Agent Desktop supports multi-line phones. However, the number of lines supported is limited. You cannot
log into a phone that has more than four lines (one ACD line and three non-ACD lines).

Only two calls per line are supported.

Logging in as a Local Agent

Note: If you are using Cisco IP Communicator as your phone, you must start IP Communicator
before you log into Agent Desktop.

To log in as a local agent:

1. Choose Start > All Programs > Cisco > Desktop > Agent. The Agent Login window appears.

Note: The Agent Login window prompts for either your name or your ID, depending on the
method that your CAD administrator configured.

2. Type your login name/ID, password, and extension in the appropriate fields, then click OK.
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If your configuration includes Cisco Unified Presence Server, and your Unified Presence Server login
is different from your Agent Desktop login, the Cisco Unified Presence Server Login window appears.
Type your Unified Presence username and password and click Login.

If your configuration does not include Cisco Unified Presence Server, or your Unified Presence Server
login is the same as your Agent Desktop login, Agent Desktop starts and is automatically minimized.

Note: Do not attempt to log into Cisco Unified Presence through both Agent Desktop and Cisco
Unified Personal Communicator, even if you use different user IDs to do so. If you do, the client
applications can behave unpredictably.

Note: The first time you log in using Agent Desktop, the Login Name/ID, Password, and Extension
fields are empty. The next time you log in, the Login Name/ID and Extension fields are
automatically filled with the information you entered previously. If you share a computer with
another agent, verify that the Login ID/Name and Extension fields have your information and not
the other agent’s information.

Note: When one node of a Unified Presence high availability system is unreachable, Agent
Desktop will be unable to log into Unified Presence. When the node becomes reachable, you
must log out of Agent Desktop and log in again in order to receive the Unified Presence login
dialog box.

n If you enter a login name/ID that is already in use by another agent, a dialog box appears, asking if you
want to log out the ID. If you choose yes, CADwill log out the agent using that ID and will log you in.
This is known as a “forced login.”

n If you enter an extension that is already in use by another agent, an error message appears, stating
that the extension is already in use. You must enter a different extension to log in.

n If the login method (Login Name or Login ID) is changed while you are logging in, an error message
appears, stating that the login method has changed. You must restart Agent Desktop to log in.

n If your team assignment is changed, then you must restart Agent Desktop for the change to go into
effect.
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Logging in as a Mobile Agent

When you log in as a mobile agent, you can use any phone to receive calls that is accessible to the
contact center phone system, including home phones and cell phones that are not directly connected to
the contact center.

The Agent Login window you see might not display the Mobile Agent Mode check box. If you need to log in
using mobile agent mode and the check box is not visible, ask your CAD administrator to enable it.

Note: The instructions in this document about using Agent Desktop do not address important
differences that apply when you log in as a mobile agent. Consult the “Using Unified Mobile
Agent” section of theMobile Agent Guide for Cisco Unified Contact Center Enterprise & Hosted
for instructions on using your desktop when you log in as a mobile agent.

Note: You must use Agent Desktop for all call control operations as described below. If you use
your phone for call control, you might lose the call. Also, use Agent Desktop to monitor call
activities, such as conference status. This information is not displayed accurately (or not at all in
some cases) on your phone. Consult your Cisco Unified Mobile Agent documentation for more
information.

You can receive calls in either of two modes, Nailed Up Call mode or Call by Call mode.

n In Nailed Up Call mode, you receive one call that you answer using your physical phone when you log
in. That line stays connected through multiple customer calls. Agent Desktop plays a phone ring sound
file when a customer call arrives, and you perform all call control through Agent Desktop, including dis-
connecting the call. If you hang up your physical phone, you are logged out.

n In Call by Call mode, your physical phone is dialed for each customer call. Once you answer your phys-
ical phone, all call control is performed through Agent Desktop, including disconnecting the call.
When you hang up by disconnecting the call through Agent Desktop and then by hanging up your phys-
ical phone, you are placed in the Ready state and made available to receive another customer call.

Note: If you are not configured as a mobile agent, or if you choose a call mode you are not set up
to use, your mobile agent login will fail. If this occurs, contact your administrator.

It is recommended that you use VPN to access your contact center network in order to have a more secure
connection before you log in to Agent Desktop. See your VPN instructions for more information.

To log into Agent Desktop as a mobile agent:
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1. Choose Start > All Programs > Cisco > Desktop > Agent. The Agent Login window appears.

2. Type your login name/ID, password, and extension in the appropriate fields.

3. Select the Mobile Agent check box. The Mobile Agent Login window appears.

4. In the Mobile Agent Parameters section, select the call mode you want to use and type your phone
number in the Mobile Agent Phone Number field.

Enter only numbers in the Mobile Agent Phone Number field. This field cannot include spaces, dashes,
parentheses, or other non-numeric characters.

5. Click OK or press Enter to log in. Agent Desktop starts and is automatically minimized.

Note: If your team assignment is changed while you are logged in, then you must restart
Agent Desktop for the change to go into effect.

Login Notes
n The Login Name field has a maximum of 32 characters. The Login ID, Extension, and Password fields

have a maximum of 12 characters.

13



Logging In

n When you log in, you might see the error message, “A licensing error has occurred. Please see your
administrator.” This generally appears when all Agent Desktop software licenses are in use. For this
reason, it is important that you close Agent Desktop completely when you are done using it, rather
than simply logging off. As long as Agent Desktop is running, one license is being used.

n If you log in as a mobile agent using Nailed Up Call mode, you have only one phone line, and your
phone line is busy, you are logged in and immediately logged out. If you have two phone lines with
voice mail on the non-busy line, mobile agent rolls over to the second line, logs you in, and then when
the voice mail hangs up, logs you out.

n When you are logging in as a mobile agent, you cannot log out a login name/ID that is already in use. If
you see a dialog box asking if you want to log out the agent name/ID (force your login), answer No.
You must log in with a different login name/ID.

Access Through a VPN

Agent Desktop is able to connect to the CAD servers through a virtual private network (VPN). This allows
an agent to work remotely and still have the benefits of the full functionality of Agent Desktop.

Using a VPN is recommended in order to provide a more secure connection.

When a desktop is using network address translation (NAT) due to a firewall or router, then VPN software
must be used on the desktop to ensure full bi-directional network connectivity between the contact center
servers and the desktop. Failure to use VPN software will result in connectivity issues and a loss in
functionality such as silent monitoring, recording, and incoming chat message and teammessage failures.

Cisco AnyConnect Secure Mobility Client is verified to work correctly with Agent Desktop.

VPN solutions from other vendors might result in feature loss. Because they have not been formally
verified, they are not supported.

Note: After installing Cisco AnyConnect Secure Mobility Client, you must restart your computer. If
you do not restart, monitoring and recording will not work properly.

VPNTunneling

There are two types of VPN tunneling mechanism, full tunneling and split tunneling, both of which are
supported for connection between Agent Desktop and CAD services.

VPN Full Tunneling

VPN full tunneling virtually replaces the network connection with the local area network defined by the
VPN. If VPN full tunneling is used to connect to CAD servers, the VPN connection must be established
before starting Agent Desktop. If the VPN connection is lost during a session, you must close Agent
Desktop, reestablish the VPN connection, and then restart Agent Desktop.

VPN Split Tunneling
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VPN split tunneling allows you to access a public network and a local area network simultaneously, using
the same physical network connection.

There are two types of VPN split tunneling scenarios.

n Scenario 1: The CAD servers are on the public network and a third-party application is used through
the VPN. In this scenario, you must launch and log into Agent Desktop before establishing the VPN
connection. If the VPN connection is lost during a session, you must restart Agent Desktop and then
reestablish the VPN connection.

n Scenario 2: The CAD servers are on the VPN and a third-party application is used through the public
network. In this scenario, you must establish the VPN connection before launching Agent Desktop. If
the VPN Connection is lost during a session, you must close Agent Desktop, reestablish the VPN con-
nection, and then restart Agent Desktop.

If Agent Desktop can log into all services except the Chat service, it must be restarted after the Chat
service comes back online.
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You can log out only from the Not Ready agent state.

When you start Agent Desktop, you use a software license. When you close Agent Desktop, that software
license is released so it is available for another agent to use. For this reason, it is important to close Agent
Desktop when you are done using it.

If you just log out, the software license remains in use and some features of Agent Desktop, such as Chat,
are still available.

There are two methods of logging out and closing Agent Desktop.

Method 1 (Recommended)

In this method, you log out and then close Agent Desktop. This ensures that the software license you are
using is released and is available for other agents to use.

To log out usingMethod 1:

1. Click Logout on the toolbar.

n If your system is configured to require reason codes, before you are logged out the Reason Code
dialog box appears. Choose the appropriate reason code and click OK.

n While you are on a call, the Logout button is disabled. The Logout button will be enabled when
you terminate the call.

2. Click Close (the X in the upper right corner of the Agent Desktop window) to exit Agent Desktop.

Method 2

With this method there is a small chance that the logout will not properly release the software license.

An agent can force the license to be release by using a forced login. See Logging In

To log out usingMethod 2:

n Click Close (the X in the upper right corner of the Agent Desktop window).

If your system is configured to require reason codes, before you are logged out the Readon Code
dialog box appears. Choose the appropriate reason code and click OK.

If you are on a call when you click Close, a dialog box appears asking you to confirm that you want to
log out.

n If you click Yes, you will be logged out of Agent Desktop but you will retain the call.

n If you click No, you will remain logged in and Agent Desktop will remain open.
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The Agent Desktop Interface
The Agent Desktop interface displays information about active calls and provides phone call handling
functions. It also:

n Provides access to websites in its integrated browser

n Displays agent and call statistics in real time

n Allows you to record calls using task buttons (if configured by the administrator)

n Allows you to chat with other agents and supervisors using Chat instant messaging

The interface includes the following parts:

n Toolbar

n Teammessaging pane

n Contact appearance pane

n Contact management pane

n Integrated browser

n Status bar
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Accessibility

Agent Desktop has several features that improve accessibility for low-vision and vision-impaired users.

n Use of Windows settings for screen resolution, color/contrast, and font settings

n Scrolling or non-scrolling teammessages

n Shortcut keys and tool tips that are compatible with screen readers

n Toolbar buttons available in small (16 × 16) and large (32 × 32) sizes

n Audible tones that sound when a non-agent-initiated dialog appears (for example, new chat windows
and notification about the supervisor barging in, intercepting, recording, or monitoring a call)

n Navigation through each pane, browser, and all the elements of the main window using the Tab key

n The space bar can act as the Enter key for dialog boxes in focus (for example, in the Dial Pad window
you can press the space bar to select the focused number and Enter to make the call)

n Support for Job Access With Speech (JAWS) 11 screen reader software

For information about configuring accessibility options, see Desktop Preferences.
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Toolbar and Shortcut Keys

The dashboard toolbar contains buttons for call control and for functions not related to a specific customer
contact, such as logging in and out, changing your agent state, initiating a chat session, viewing real time
displays, and configuring the appearance of the Agent Desktop interface.

Call control and agent state buttons on the toolbar are disabled if they control a function that is
unavailable in your current situation. For example, if you have placed a call on hold, all other call control
buttons are disabled. When you take the call off hold, the other call control buttons are enabled again. To
view the name of a button, move the cursor over the button icon.

Note: If your contact center is using the Enhanced or PremiumCAD package, your toolbar can be
configured by your administrator and might contain different buttons than those listed below.

You can control the size of the toolbar buttons. See Desktop Preferences for more information.

The toolbar buttons all have tool tips that describe the function associated with them. To view a button’s
tool tip, move your cursor over the button.

The optional Cisco Unified Outbound Dialer toolbar can be configured to appear in Agent Desktop by your
administrator. Depending on the dialing mode of the calling campaign that your administrator sets up, the
toolbar will contain some or all of the available nine buttons. For a complete description of the toolbar, see
Cisco Unified Outbound Dialer Toolbar.

n Press Alt+T to select Agent Desktop’s main toolbar

n After selecting the toolbar, press Tab, Shift+Tab, or the arrow keys to move through the buttons in the
toolbar

n Press Ctrl+Tab or Ctrl+Shift+Tab to navigate to other toolbars

n Press Esc to exit the toolbar

n Press Enter to select the currently focused item

The following tables list the toolbar buttons and shortcut keys that you can use in Agent Desktop.

Button Name Shortcut Description

Answer/Drop Ctrl+A Answers or drops the selected call.

Hold/Unhold Ctrl+H Places the selected call on hold or
takes it off hold.

Conference Ctrl+F Places the selected call on hold and
opens the Conference a Call window.

Call Handling Buttons
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Button Name Shortcut Description

Transfer Ctrl+T Places the selected call on hold and
opens the Transfer a Call window.

Touch Tones Ctrl+D Opens the Enter Touch Tones window.

Call Handling Buttons (cont'd)

Button Name Shortcut Description

Login Ctrl+L Logs you into the ACD (alternates with
Logout).

Logout Ctrl+L Logs you out of the ACD (alternates
with Login).

Ready Ctrl+W Changes your state to Ready, indic-
ating that you are available to receive
ACD calls.

Not Ready Ctrl+O Changes your state to Not Ready,
indicating that you are not available to
receive ACD calls.

Work Ready Ctrl+Y Changes your state to Work Ready,
indicating that you will be available to
receive ACD calls after you finish
wrap-up work.

Work Not Ready Ctrl+Z Changes your state to Work Not
Ready, indicating that you will not be
available to receive ACD calls after
you finish wrap-up work.

Agent State Buttons

Button Name Shortcut Description

Make Call Ctrl+M Opens a window fromwhich you can
dial a call.

Window Management Buttons

21



The Agent Desktop Interface

Button Name Shortcut Description

Task1–10 Alt+<button num-
ber>

(Enhanced/Premium only) Task but-
tons are configured by your admin-
istrator to perform various functions,
such as running a macro, launching an
application, or sending a predefined
chat message to your supervisor.
There can be up to ten task buttons on
the toolbar, and each button can be
assigned more than one action. The
buttons can be customized, so yours
might be different.

Chat Ctrl+J Opens a window fromwhich you can
initiate a chat session.

Real Time Display Ctrl+Q Opens a window that displays your call
logs and statistics.

Contact Mgmt Ctrl+G Shows or hides the Contact Man-
agement pane.

Browser Alt+B (Premium only) Shows or hides the
Integrated Browser pane.

Preferences Alt+P Opens a window for configuring your
desktop preferences.

Help/About Alt+H Opens a menu listing the Help and
About options. Use the up and down
arrow keys to select an option.

— Help F1 Opens the Help window.

— Service Status Ctrl+Shift+S Opens the Service Status window.

Window Management Buttons (cont'd)

The following table lists the shortcut keys for moving the cursor to various text elements in the Agent
Desktop interface so a screen reader can read the text.

Shortcut Keys Description

Ctrl+E Selects the first entry in the Enterprise Data pane. Press Enter to open
the Edit Enterprise Data dialog box for the selected entry.
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Shortcut Keys Description

Ctrl+S Selects a contact in the Contact Appearance pane.

Ctrl+Shift+L Selects an e-mail in the Contact Appearance pane.

Ctrl+Shift+E Selects a row in the Contact Management Call Activity pane.

Ctrl+Shift+M Reads the teammessage.

JAWSKEY*+Page Down Reads the status bar.

JAWSKEY*+T Reads the title bar.

JAWSKEY*+Ctrl+n Reads the column header along with its value, where n is the desired
column number For example, the call contact appearance pane in
Agent Desktop can be announced as “State: Connected, Calling Num-
ber: 1114, Called Number 1194.” For such an announcement, you
must press JAWSKEY+Ctrl+1 to announce the State column header,
JAWSKEY+Ctrl+2 to announce the Calling Number header, and
JAWSKEY+Ctrl+3 to announce the Called Number header and their
respective values.

* By default, the JAWSKEY is the Insert key. For more information on using JAWS, see the JAWS
documentation.

The following table lists the shortcut keys for the Agent Real Time Display window.

Shortcut Keys Description

Alt+R Selects the Real Time Displays drop-down list.

Alt+T Opens the Dates drop-down list. Available only when the Agent Call
Log Display is selected.

Alt+C Selects the first cell in the grid.

The following table lists the shortcut keys for the Dial Pad window.

Shortcut Keys Description

Alt+P Selects the first entry in the Employee Phone Book.
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TeamMessages

The teammessage is a scrolling or non-scrolling message sent to you and the rest of your team by your
supervisor for a specific length of time. You will receive a teammessage even when you are logged out, as
long as you do not close Agent Desktop.

When there is no message, the teammessage pane is not visible. As soon as your supervisor sends your
team a teammessage, the teammessage pane opens and the message scrolls across it.

Contact Appearance Pane

The contact appearance section displays data about the agent’s current call appearances. There can be
more than one call appearance in the section. For example, you might have one call on hold and one
active call—both will be displayed.

The contact appearance pane can display up to nine fields. The State field will always be present; the
other eight fields are configurable by your administrator.

Field Description

State The current state of the contact.

Calling# The number of the originating device.

Called# The number of the destination device.

Alerting# The number of the ringing device.

Original Called# The original number called.

Original Calling# The initial originating number.

Duration The length of the phone call.

Skill The skill ID, displayed only if the call is an inbound ACD call.

ACD Line Yes/No. INdicates if the call is on an ACD or non-ACD line.

Some fields might display <unavailable> or be blank if the call information is unknown or does not exist.

Whenever the IP IVR is involved in a call, Agent Desktop displays the same information about the call in the
contact appearance pane as your IP phone displays on its screen. Enterprise Data might display different
data because it tracks the entire life of the call.

Single vs. Multi-lineContact Displays

Depending on how the system is configured, Agent Desktop can display either ACD calls only or both ACD
and non-ACD calls.
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n ACD calls only (single line configuration). Your phone has one or more extensions, but only calls des-
ignated as ACD calls will appear in the contact appearance pane.

n Both ACD and non-ACD calls (multi-line configuration). Your phone has more than one extension
and both ACD and non-ACD calls will appear in the contact appearance pane.

Contact Management Pane

The contact management pane contains enterprise data on the left and call activity information on the
right for all inbound and outbound calls.

You can use the Show/Hide Contact Management button on the dashboard toolbar to show or hide this
pane.

EnterpriseData

The enterprise data section displays data associated with the selected call. The exact data that is
displayed is configured by your administrator.

If you are set up by the administrator to be able to edit data fields, you can modify any of the data fields in
the enterprise data window while the call is active. The modified data will follow the call.

Once the call is dropped, the enterprise data can no longer be modified.

Tomodify a data field:
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1. Double-click the field you want to modify. The Edit Enterprise Data window appears.

2. Modify the data as desired.

3. Click OK.

Call Activity

The call activity section displays the call activity for the selected call. The following table lists the
available fields.

Field Description

Device List of devices the call passed through.

Type Type of device the call passed through.

Description Description of the device the call passed through.

Total Sum of all the durations listed.

Note: In some cases, a call can be on multiple devices simultaneously. For example, if a call is
placed in multiple queues or is conferenced to multiple extensions, the call activity section
displays the sum of duration of the call on the device and the duration for which the call was in
the queue. The total duration is the sum of all durations, some of which might overlap.

Note: If a call is RNA (ring no answer) at one agent and then the call is rerouted to and answered
by another agent, the total time shown in the second agent's Call Activity pane is incorrect.
However, in any reports seen by the agent or supervisor, the total call time is correct.
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Thresholds

A threshold is the acceptable amount of time a call can remain at a particular device or contact center.
Your system administrator might assign caution and warning threshold values to each device type, as well
as a total threshold value for a call.

If a call remains at a device longer than the defined caution and warning thresholds, a caution or warning
icon is displayed in the call activity pane next to the device. These icons are:

Caution Warning

Integrated Browser Pane

The integrated browser pane displays internet or intranet web pages to help you assist customers. Your
administrator can configure a specific website to display as your home page, and add a list of work sites
(similar to browser “favorites”) that allow you to navigate to frequently-used websites quickly.

The integrated browser pane includes the following parts:

n Integrated browser toolbar

n Work Sites drop-down list

n Editable Address field (if configured by the administrator)

n Browser

For more information about this pane, see Using the Integrated Browser.

Status Bar

The status bar displays current information about Agent Desktop.

From left to right, the status bar displays the following information:

n Agent name, as configured in ICM

n Agent extension, as entered when logging in

n Agent ID or Name, as entered when logging in
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n Current aget state and the time spent in that state

n Status of Agent Desktop features

n System time in 24-hour format

n Agent’s mobile phone number, as entered when logging in (mobile agents only)

If a service fails, the status changes from “In Service” to “Partial Service” or “No Service”. To view the
features that are affected by the service outage, double-click the status field. A popup window appears
that displays the features that are active or inactive.

For more information on the Service Status popup window and service autorecovery, see Service Status
Window.

Desktop Preferences

If your administrator configures your toolbar so that you have access to the Preferences button, you can
change your Agent Desktop window behavior and accessibility options.

To set your desktop preferences:
1. click Preferences on the toolbar. The Desktop Preferences dialog box appears.

2. Select the preferences you desire on each tab, and then click OK.

Window Behavior and Options

By default, Agent Desktop is minimized when it is idle and opens when calls are active (Normal mode). If
your administrator has enabled you to choose your window behavior mode, you can change the window
behavior and window options modes on the Preferences tab in the Desktop Preferences dialog box.

If your administrator has not enabled you to choose your window behavior mode, this tab is hidden and the
window behavior is set to the mode your administrator selects.
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Field Description

Normal Default. The window appears when calls are present and minimizes
when idle.

Keep open The window remains open when idle.

Always on top The window remains open when idle and on top of all other open
applications.

Note: When you select this behavior, you cannot select the
Real time displays and Dial pad always on top options.

Stealth The window appears as an icon in the system tray (lower right corner
of your desktop, next to the system clock) and does not appear unless
you double-click ir or if you receive a teammessage or an e-mail.

Real time displays always
on top*

The Agent Real Time Displays window remains open when idle and on
top of all other open applications.

Dial pad always on top* The Dial Pad window remains open when idle and on top of all other
open applications.

* If both real time displays and dial pad options are selected to be always on top, the most recently
selected window will be on top.
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Accessibility Options

The Accessibility Options tab enables you to control how certain aspects of Agent Desktop appear to you.

The following table defines the available options.

Option Description

Scroll TeamMessages If you use a screen reader with Agent Desktop, scrolling team
messages (the default mode) can be difficult to read. You can opt to
turn off the scrolling feature and have stationary teammessages by
clearing the Scroll TeamMessages check box.

Your selected teammessage behavior will persist from session to
session, and does not need to be reset each time you start Agent
Desktop.

Large Toolbar Buttons You can change the size of the buttons on the toolbar from the default
16 × 16 pixels to 32 × 32 pixels by selecting this check box. If all of the
large buttons do not fit on one row, they automatically wrap to another
row.
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Option Description

Audio Feedback on Non-
Agent-Initiated Dialogs

Select this check box to enable the sounding of a tone when a dialog
initiated by someone other than you appears on your desktop.
Examples of such dialogs are new chat windows and notifications that
a supervisor is barging in, intercepting, recording, or monitoring your
call.

Accessible Call Duration
Updates

Select this check box to prevent screen readers such as JAWS from
reading the Duration field in the call contact appearance pane. This
ensures that screen readers do not continually read off the duration as
it increments.

Focus on TeamMessages Select this check box to enable Agent Desktop to switch focus to the
teammessage pane whenever a teammessage appears. This allows
visually-impaired agents’ screen readers to read the incoming team
message.

Change Report Font Size To Select this check box and enter a point size in the field to make the
fonts bigger or smaller in the real time displays. You can choose a font
size between 15 points and 72 points. The default size is 15 points.

Note: If you change your font size using the display settings in
Windows Control Panel, you must restart Agent Desktop for
those changes to take effect.

Dial Pad

The dial pad window allows you to make phone calls by entering a number in the Name: Number field, by
selecting a number from the recent call list, or by selecting a number from a phone book.

You can enter the number either by typing it or by clicking the number keys. You can also press Alt+P to
select the first entry in the Employee Phone Book.

31



The Agent Desktop Interface

Note: “Dial pad” is the general name for this window. The name that appears in the title bar
depends on the task you are doing, and can be Make a Call, Transfer a Call, or Conference a
Call.

Once you open the dial pad window, it can stay open while you switch to other windows. This allows you
to use other Agent Desktop features, such as the integrated browser or real time displays, while waiting for
a call you make to be answered.

When the dial pad window is open, all call control buttons in the main Agent Desktop window are disabled
except for the Drop button.

When you want to transfer a call or make a conference call, and the Make a Call dial pad is open, you
must close the dial pad first and then click the Transfer or Conference button on the task bar to open the
appropriate type of Dial Pad window.

Recent Call List

When you dial a phone number, it is automatically stored in the recent call list. This list stores up to 100
entries. As the number of entries exceeds 100, the oldest phone number is removed from the list.

Agent Desktop checks to prevent duplicate phone numbers from appearing in this list. However, if the
same phone number is entered twice using different formats, for instance, 555-1212 and 5551212, both
numbers will appear on the list.
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PhoneBooks

Phone books are phone number lists set up by you (your employee phone book) and the system
administrator (public phone books).

Note: Your administrator can configure Agent Desktop so that one or both types of phone books
are not available.

Employee Phone Books
Your employee phone book is the only one you can edit. All others are controlled by your administrator.
Your phone book can have an unlimited number of entries.

To edit your employee phone book:

1. In the dial pad window, choose Employee Phonebook from the Phone Books drop-down list, and then
click Edit. The Phone Book Editor window appears.
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2. Make one of the following edits:

n To add a new entry to the list, complete the First Name, Last Name,and Phone Number fields and
click Add. Only the Phone Number field is required.

The Phone Number field allows only these characters:

0–9, a–z, A–Z,( ) + ; / : . = ? and a space

If you enter any other character, a message appears listing the allowable characters. The
disallowed character you typed will be replaced by a question mark so you can change it to an
allowed character.

Depending on how your administrator has configured the dial plan, Agent Desktop might convert
letters to their numeric equivalents on the dial pad. For example, For example, A, B, and C are
converted to the number 2.

n To edit an existing entry, select it to display it in the edit fields, click Edit, and then make your
changes. You cannot remove the phone number from the entry. If you want to edit more than one
entry, you can edit the first entry, and then double-click the next entry to save the changes you
made to the first entry and move on to the next entry.

n To delete an entry from the list, select it and then click Delete.

3. When all your edits are completed, click OK.

Phone Book Filter
You can use the phone book filter to find phone book entries more easily. The filter enables you to limit the
entries listed in the phone book window. You can use any of the four phone book fields to filter the entries.

To use the phone book filter:
1. In the dial pad window, select the Filter check box.

2. From the Filter drop-down lists, select how you want to filter the entries. In the first two drop-down
lists, select your filter criteria: the field to filter by, and the filter method. In the third field, enter the
filter string.

For example, if you want to see all phone book entries for persons whose last name begins with “J”,
select “Last Name” from the first drop-down list, “Begins with” from the second drop-down list, and
enter J in the third field.

The filter operates as soon as you enter your filter string in the third field.

3. To stop the filtering the phone book, clear the Filter check box or delete the filter string in the third
field. The entire phone book will once again be visible.

Name: Number Field
Use the Name: Number field to enter the phone number you want to dial. Entering a name is optional, but if
one is entered, it must be followed by a colon and a space to separate it from the phone number:

John Doe: 612-555-1212
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You can enter phone numbers with or without spaces, parentheses, and dashes. Agent Desktop ignores
any non-alphanumeric characters.

You can also select a phone number from the recent call list or a phone book, which is then displayed in
the Name: Number field.

Depending on how your administrator has configured the dial plan, Agent Desktop can automatically add
the local access and long distance access codes to numbers you enter..

Dial Number as Entered Check Box
To prevent automatic formatting (such as local access and long distance access codes), select the Dial
Number as Entered check box before clicking Dial. When you select this check box, Agent Desktop dials
the number exactly as you entered it in the Name: Number field.
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When logged in as an agent, you can use Agent Desktop, a hard IP phone, or IP Communicator to handle
phone calls.

Note: See your IP phone documentation for explanations of your phone’s functions and features.

The procedures in this section assume you are using the Agent Desktop interface to handle calls.

Single-line vs. Multi-line Configurations

If your system is configured for single-line use, then Agent Desktop controls and displays only ACD calls.
You cannot answer non-ACD calls with Agent Desktop; these calls do not appear in the contact
appearance pane and must be answered using your hard IP phone or IP Communicator.

If your system is configured for multi-line use, then Agent Desktop controls and displays calls received on
both the ACD and non-ACD extensions. To control any call on the Agent Desktop contact appearance
pane, select the call in the pane and then perform the desired activity.

For both single-line and multi-line configurations, you must be logged in and be in the Ready state to
receive an ACD call. If your system is configured for multi-line use, you can be in any state to receive a
non-ACD call.

You can transfer a call from the ACD extension to the non-ACD extension through the phone or the call
control buttons in Agent Desktop. However, you cannot transfer a call from the non-ACD extension to the
ACD extension using Agent Desktop; the transfer must be initiated through the phone in order to succeed.

If you transfer a call from the ACD extension to the non-ACD extension, you must answer the call on the
non-ACD extension using your phone and not the call control buttons in Agent Desktop.

Entering Phone Numbers

When dialing a phone number, you can use three different methods to enter the phone number into the dial
pad’s Name: Number field:

n Type the phone number on your PC keyboard

n Select the numbers from the dial pad window

n Select an existing number from the Recent Call List or a phone book

You can enter a number only, or you can enter a name and number. Use the format name: number. You
must include the colon and a space to separate the name from the number:

John Smith: 5551212
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When you enter the number, it doesn’t matter whether you include dashes, parentheses, or spaces; only
the numbers are read. Depending on how Agent Desktop is configured, you might not have to include the
local access or long-distance access codes. Consult your system administrator for information.

In the following sections, whenever you are instructed to enter a number in the Name: Number field, you
can do so using any one of these methods.

Answering a Call

Use the Answer/Drop button to answer a call.

To answer a call:
n Click Answer.

To end a call:
n Click Drop.

Making a Call

You must be in the Not Ready state to make a call. The Make Call button is disabled when you are in the
Ready State.

Tomake a call:

1. Click Make Call. The Make a Call dialog box appears.

2. Enter a number in the Name: Number field.

3. Click Dial.

Note: If you are a mobile agent using Call by Call mode, your phone rings before the destination
phone does when you place an outbound call. You must answer your own phone first, and then
the destination phone rings.

Note: If you are a mobile agent and make a call to a busy phone, you will not hear a busy tone,
just silence. However, the contact appearance pane displays the Busy state.
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Entering Touch Tones

If you need to send touch tones during a call (for instance, if you are prompted to enter an account
number) you can do so using the Touch Tones button. This button activates a number pad on which you
enter the required numbers.

You can also enter touch tones when transferring or conferencing a call.

During a Call

To enter touch tones during a call:

1. Click Touch Tone when you are prompted to enter numbers during a call. The touch tones number pad
appears.

2. Enter the required numbers and/or symbols.

3. Click Done when you are finished. The number pad closes and you are returned to the Agent Desktop
interface.

When Transferring or Conferencing a Call

You might also need to send touch tones during a consultative call. For example, after you open the
Conference a Call window and dial a number, you might be prompted by an IVR to enter one or more
numbers indicating a menu choice. You can send touch tones during a consultative call either by clicking
the appropriate buttons in the Touch Tones window or by typing the appropriate numbers in the Dial Pad
window.

To enter touch tones when transferring or conferencing a call:
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1. During a call, click Transfer or Conference. The Transfer a Call or Conference a Call dialog box
appears.

2. Make the consultative call. The person you are calling must answer in order for the Touch Tones
check box to become enabled.

3. At the IVR prompt, select the Touch Tones check box, and then enter the required numbers and/or
symbols on the number pad. The appropriate tone is generated immediately after each digit or symbol
you enter.

Note: The Touch Tones check box is automatically cleared when you close the Transfer a
Call or Conference a Call window.

Transferring a Call

There are three types of transfers:

n Supervised transfer. This type of transfer is available to every Agent Desktop user, and is triggered by
clicking the Transfer button on the toolbar. In this type of transfer, you specify the number to which
you want to transfer the active call. You can either hang up before the third party answers, or stay on
the line and speak to the third party before actually transferring the call.

n Blind transfer. This type of transfer is available only if your administrator has configured a task button
with the blind transfer action. In this type of transfer, the active call is transferred directly to a pre-
defined phone number. Once you click the blind transfer task button, the call is transferred to that num-
ber and you are no longer connected to the call.

n Single-step transfer. This type of transfer is available only if your administrator has configured a task
button with the single-step transfer action. In this type of transfer, you specify the number to which
you want to transfer the call. Once you do that, the call is transferred directly to the third party and you
are disconnected from the call.

Note: If failover occurs while transferring a call, the dial pad window closes. You must end the
call to the transfer recipient and initiate the call again in order to transfer the call on hold.

To transfer a call:
1. With a call active, click Transfer. The Transfer a Call window appears.

2. In the Name: Number field, enter the phone number to which you are transferring the call.

3. Click Dial. The active call is put on hold, and when the phone rings, the Dial button changes to the
Transfer button.

4. Do one of the following:

n Click Transfer when the phone starts ringing. The call is transferred and you are disconnected
from the call.
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n Wait for the phone to be answered, announce the transfer, and then click Transfer. The call is
transferred and you are disconnected from the call.

If you opt to announce the transfer, you can click Alternate to switch between the two calls. See
Alternating Between Calls.

To transfer a call using the blind transfer action:
n With a call active, click the task button assigned to the blind transfer action. The call is transferred to

the predefined phone number and you are disconnected from the call.

To transfer a call using the single-step transfer action:
1. With a call active, click the task button assigned to the single-step transfer action. The Transfer a Call

dialog box appears.

2. In the Number field, enter the phone number to which you are transferring the call.

3. Click Transfer. The Transferring Call window closes, the call is transferred to the phone number, and
you are disconnected from the call.

Conferencing a Call

You can add other parties to an active call to make a conference call. There are three types of conference
calls:

n Supervised conference. This type of conference is available to every Agent Desktop user, and is
triggered by clicking the Conference button on the toolbar. In this type of conference, you specify the
number you want to conference in to the active call. You can either add the third party to the call
without first speaking to him or her, or speak to the third party before actually completing the con-
ference call.

n Blind conference. This type of conference is available only if your administrator has configured a task
button with the blind conference action. In this type of conference, a predefined phone number is con-
ferenced directly in to the active call.

n Single-step conference. This type of conference is available only if your administrator has configured
a task button with the single-step conference action. In this type of conference, you specify the num-
ber to be conferenced directly in to the active call.

Note: If you use a blind conference to add someone to your call, the call might be tagged as a
conference call.

Note: If you log out while on a conference call and then log in again, enterprise data field names
will not be displayed in the Enterprise Data pane. The field names will be displayed for the next
call you handle.

Note: If failover occurs while conferencing a call, the Dial Pad window closes. You must end the
call to the conference recipient and initiate the call again in order to complete the conference.
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Tomake a conference call:
1. With a call active, click Conference. The Conference a Call window appears.

2. In the Name: Number field, enter the phone number of the person you want to add to the call.

3. Click Dial. The party is put on hold, and when the phone rings, the Dial button changes to the Add to
Conf button.

4. Take one of the following actions:

n Click Add to Conf when the phone starts ringing. The third party is added to the conference.

n Wait for the phone to be answered, then announce the conference. Click Add to Conf to add the
person to the conference.

If you opt to announce the conference, you can click Alternate to switch between the two calls. See
Alternating Between Calls.

5. To add one or more people to the conference call, repeat Steps 1 through 4 for each person.

To conference a call using the blind conference action:
n With a call active, click the task button assigned to the blind conference action. The predefined

phone number is conferenced directly into your call.

To conference a call using the single-step conference action:
1. With a call active, click the task button assigned to the single-step conference action. The Con-

ference a Call window appears.

2. Enter the phone number you want to conference into the phone call in the Number field and click Add
to Conf. The phone number is conferenced directly into your call.

Note: The maximum number of conference call participants is configured in the Unified
Communications Manager. Ask your supervisor for the number configured for your contact
center.

Alternating BetweenCalls

The Alternate function allows you to switch between two parties before transferring a call or adding a call
to a conference.

Alternating Before Transferring a Call

The Alternate function allows you to talk to Party A and Party B separately before completing the transfer
of Party A to Party B.

To alternate between calls before transferring:
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1. While on a call, click Transfer. The Transfer a Call window appears.

2. Enter the phone number to which you are transferring the call in the Name: Number field, and then
click Dial. When the phone rings, the Dial button changes to the Transfer button. Wait for Party B to
answer the phone.

3. Click Alternate to speak to Party A, and then click Alternate again to speak to Party B. You can con-
tinue clicking Alternate to switch between Party A and Party B. When you speak to one party, the
other party is put on hold.

4. Click Transfer. Party A is transferred to Party B and you are disconnected from the call.

Alternating BeforeConferencing a Call

The Alternate function allows you to talk to a conference call and Party B separately before adding Party B
to the conference call.

To alternate between a conference call and another party:
1. While on a call, click Conference. The Conference a Call window appears.

2. Enter the phone number of the person you want to add to the conference call in the Name: Number
field, and then click Dial. When the phone rings, the Dial button changes to the Add to Conf. button.
Wait for Party B to answer the phone.

3. Click Alternate to speak to the conference, and then click Alternate again to speak to Party B. You
can continue clicking Alternate to switch between the conference call and Party B. When you speak
to one party, the other party is on hold.

4. Click Add to Conf. Party B is added to the conference call.
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If configured by your administrator, your copy of Agent Desktop might include the Cisco Unified Outbound
Dialer toolbar. The buttons that appear on the toolbar are determined by the type of dialing campaign set
up by your administrator:

n Progressive. In Progressive dialing mode, a fixed number of outbound lines are dialed per agent avail-
able.

n Predictive. In Predictive dialing mode, a mathematical algorithm determines how many outbound lines
to dial for each available agent. This algorithm varies over time based on conditions in the contact cen-
ter.

n Preview. In Preview dialing mode, customer information is presented on your desktop before the cus-
tomer call is transferred to you. You have the option to accept, reject, or skip the proposed call.

n Direct Preview. In Direct Preview dialing mode, a call is ready to be dialed by the Dialer and customer
information is displayed on your desktop. When you click Accept, the call is actually dialed and you
are connected to the customer without any time lag.

Note: Cisco Unified Mobile Agent Call by Call mode does not support Unified Outbound Dialer.
Nailed Up Call mode does support Unified Outbound Dialer.

Unified Outbound Dialer Toolbar and Shortcut Keys

The following table describes the Unified Outbound Dialer toolbar buttons and shortcut keys.

Icon Name/Shortcut/Description DPrev Pred Prev Prog

Accept (Alt+Shift+A)

The system dials the customer and
transfers the call to you.

x x x x

Reject (Alt+Shift+R)

The system rejects the current call and
releases you from the outbound calling
reservation. At this point, the system can
deliver to you another outbound call or a
new inbound call.

x x

Reject Close (Alt+Shift+U)

The system rejects the current call and
closes the record so it will not be called
again.

x x
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Icon Name/Shortcut/Description DPrev Pred Prev Prog

Skip (Alt+Shift+S)

The system skips the current call and
presents you with another customer call.

x x

Skip Close (Alt+Shift+T)

The system skips the current call and
closes the record so it will not be called
again.

x x

Skip-Next (Alt+Shift+K)

The system skips the call and displays a
menu of these options:

Wrong Number (Alt+Shift+W): You are
informed that the number called is a
wrong number. After the call terminates,
the system calls other customer phone
numbers.

Not Home (Alt+Shift+N): You are
informed that the customer is not home.
After the call terminates, the system
calls other customer phone numbers.

x x x x

Callback (Alt+Shift+C)

Displays the Callback Properties
window. This window enables you to set
a date and time to call back the
customer. Callback is enabled only if you
are in a talking or wrap-up state on a
Unified Outbound Dialer call.

x x x x

Reclassify (Alt+Shift+Q)

Displays a menu that enables you to
reclassify a customer phone number as:

Voice (Alt+Shift+V)

Answering Machine (Alt+Shift+M)

Fax/Modem (Alt+Shift+F)

Invalid Number (Alt+Shift+I)

x
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Icon Name/Shortcut/Description DPrev Pred Prev Prog

Cancel Reservation (Alt+Shift+D)

The system releases you from the calling
campaign and places you in the Not
Ready state. To resume participating in
the calling campaign, you must change
your state to Ready.

x x x x

Key: DPrev = Direct Preview; Pred = Predictive; Prev = Preview; Prog = Progressive

Information about Outbound Dialer calls is displayed in the Enterprise Data pane. Unified Outbound Dialer
data field names are prefixed with “BA” (Blended Agent).

Note: If a call is part of a Preview dialing mode campaign, the first letter in the BAStatus field
entry is a “P”. If a call is part of a Direct Preview dialing mode campaign, the first letter in the
BAStatus field entry is a “D”. If a call is part of a Progressive or Predictive dialing mode campaign,
no Unified Outbound Dialer enterprise data (fields prefixed with “BA”) is available until you are
connected to the customer.

Reclassifying a Contact

A contact can be classified as either Voice or one of the other options (Answering Machine, Fax/Modem,
or Invalid).

The first time you click Reclassify, the Voice option on the drop-down menu is disabled, because the
contact is classified as Voice by default. All other options are enabled.

The next time you Reclassify, the Voice option is now enabled, and all other options are disabled.
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You can reclassify a contact as many times as needed. The reclassification options menu will alternate
between showing the Voice option enabled and the other options disabled, and the Voice option disabled
and the other options enabled. If you need to reclassify a contact from one non-voice option to another
non-voice option, you must first reclassify it as Voice in order to select the correct non-voice option.

For example, if you reclassify a Voice contact as Answering Machine, and then want to reclassify it again
as Invalid, you must first reclassify it as Voice, and only then can you reclassify it as Invalid.

Customer Callbacks

You can schedule a customer callback for a time more convenient to the customer.

To schedule a customer callback:

1. While in Talking or Wrap-up state, click Callback. The Callback Properties dialog box appears,
displaying data about the current customer call.

2. In the Schedule Callback section, enter a time (HH:MM) and date (MM/DD/YYYY) to call back the
customer.

Be sure that the time you enter in the Customer’s Time field is the time in the customer’s time zone,
not the time in your time zone. You can enter the time in 12-hour or 24-hour format. If using the 12-
hour format, you must enter AM or PM as well.

You can also change the customer number if the customer wants to be contacted at a different phone
number.
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Note: In Preview, Progressive, and Predictive modes, the number displayed in the Customer
Number field is the dialer port, not the customer’s phone number.

3. Click OK. The call is now scheduled for callback at the time and date you set.

Note: The customer callback might not be made exactly at the time you specified if the clock
on the computer hosting the ICM is set at a different time than the clock on your PC.

You can cancel a scheduled customer callback as long as you are still on the customer call (in Talking
state) or in Wrap-up state after that call.

To cancel a scheduled customer callback:
1. While in Talking or Wrap-up state, click Callback. The Callback Properties dialog box appears, dis-

playing data about the current customer call.

2. Click Clear Callback. The scheduled callback call is now canceled.
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Supervisor Intervention
Your supervisor can be involved in your contact with customers in several ways:

n By intervening in the customer call

n By pushing web pages for you to view in your integrated browser

n By changing your agent state

Call Involvement

Your supervisor can be involved in calls you receive. He or she can:

n Barge in on a call—join your call with a customer in a forced conference

n Intercept a call—transfer a customer call to him or herself in a forced transfer

n Monitor your calls

n Record your calls for review later

You are notified when your supervisor barges in or intercepts your phone call by the appearance of a
popup window. You might or might not be notified when your supervisor monitors or records your calls,
depending on how the system is configured.

Browser Involvement

Your supervisor can push (send) a selected web page to your integrated browser window. This enables
your supervisor to coach you during a call by providing information that will help you work with a customer.

The pushed web page is always displayed in the first tab in your integrated browser. Whenever the
supervisor pushes a page to you, the tab will blink to attract your attention.

Agent State Involvement

Your supervisor can change your agent state and log you out of Agent Desktop. You are not notified when
your supervisor changes your agent state. You can tell which state you are in by which agent state toolbar
button is enabled or disabled or by looking at the state field on the status bar.
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Agent Desktop allows you to change your agent state in the ACD through the use of the agent state
buttons. Only the agent states that are valid choices from your current agent state will be available at any
given time.

You can change your agent state while on a call (in the Talking state). Your state will change to the state
you clicked after you hang up the call.

The agent state buttons indicate the state you clicked, not your current state. For instance, if you click the
Work Not Ready state button while on a call, the Work Not Ready button appears to be pressed. Your
current state is displayed on the status bar.

Note: Your agent state is changed to Not Ready automatically if you do not answer your phone.
You will not receive any ACD calls until you set your state back to Ready.

Available agent states are listed in the table below.

State Description

Hold You are on the phone with a customer and have the call on hold. This
state is automatically set for you by the ACD and does not have a cor-
responding button.

Logout You are logged out of the ACD.

Not Ready You are not available to receive ACD calls.

Ready You are available to receive ACD calls.

Reserved You are temporarily set aside to receive a specific ACD call or Unified
Outbound Dialer call. Your state changes to the Talking state when you
answer the call.

If you fail to answer the call within a time limit specified by the system
administrator, the ACD places you in a Not Ready state.

The Reserved state is automatically set for you by the ACD and does
not have a corresponding button. You can be in this state without the
phone ringing (you are waiting for it to ring).

Talking You are on the phone with a customer or another agent. This state is
automatically set for you by the ACD and does not have a cor-
responding button.
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State Description

Work Not Ready You are completing work from a previous call and are unavailable to
receive ACD calls. You change to the Not Ready state when:

n You enter wrap-up data (if enabled by the administrator)

n A timer set in the ACD expires (if the ACD uses this feature)

n You manually change state after you enter wrap-up data

Work Ready You are completing work from a previous call and are available to
receive ACD calls. You change to the Ready state when:

n You enter wrap-up data (if enabled by the administrator)

n A timer set in the ACD expires (if the ACD uses this feature)

n You manually change state after you enter wrap-up data

53



Chat
Chat enables you to send instant messages to agents and supervisors on your teams. In addition, if your
configuration includes Cisco Unified Presence, you can send instant messages to non-agents (called
subject matter experts, or SMEs) who are using the Unified Presence client.

Note: If you don’t have the Chat button on your toolbar, then the administrator has configured
Agent Desktop so that you cannot initiate a chat session. However, you are still able to receive
incoming chat sessions and respond to them.

Some Chat features include:

n A chat session is between you and one other party.

n You can participate in multiple concurrent chat sessions.

n The title bar of the Chat window displays the name of the person with whom you are chatting.

n If you flag a chat message as high priority, the Chat window will pop on the other agent’s or super-
visor’s screen so the message will be noticed immediately. This option does not apply to messages
sent to SMEs.

n If the priority of a chat message is normal (the default), the Chat window will remain in its current state
(open or minimized) and the corresponding icon will flash on your Windows task bar.

n A log of the chat messages sent between you and your chat partner (the chat history) is available as
long as the Chat window is open. The chat log is in chronological order, with the oldest message at
the top. After you close the Chat window, the log is deleted.

n You can send and receive chat messages even if you are logged out of the ACD, as long as Agent
Desktop remains open.

Chat Contacts

Your contacts are organized in groupings called drawers in the Chat Selection window. Some drawers,
such as the Teammates, Supervisors, and Conference drawers, are default drawers. Any other drawers
that appear are customized by your administrator and appear only if you are logged into Unified Presence.

The example of a Contact Selection window below shows the default Teammates and Supervisors
drawers, as well as two customizable drawers, TAC and Engineering.
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n The Teammates drawer lists all the agents on your team. The agents’ agent state is indicated both by
an icon to the left of the agent name and by text to the right of the agent name. The agent state is
updated whenever an agent’s state changes. Agents do not have to be currently logged into Agent
Desktop to be listed here, but they must have Agent Desktop open and they must have logged in at
least once.

Note: You cannot chat with IP Phone agents.

n The Supervisors drawer lists all supervisors on your team. It appears only if a supervisor is logged in.
Their status is always listed as Available. Supervisors must be logged in to be listed here.

n The Conference drawer appears when you are on a conference call with other agents. SMEs, if they
are on the conference call, are not listed here.

n The Personal Contacts drawer appears if you have this drawer set up in Cisco Unified Personal Com-
municator. The contacts in this drawer are administered in Unified Personal Communicator.

n Other drawers list the SMEs associated with the work flow groups to which you belong. The SMEs’
Unified Presence status is indicated both by an icon to the left of the SME name and by text to the
right of the SME name. The Unified Presence status is updated whenever an SME status changes.

Note: When you log into Unified Presence, your status is shown as Available to SMEs unless
the administrator has configured the system so that agents appear offline.

The Chat Selection window also provides menu access to the following call handling functions:

n Making a call

n Transferring a call
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n Initiating a conference call

Chat Shortcut Keys

The following table lists the shortcut keys in the Chat window.

Shortcut Key Description

Alt+L Starts a chat session with the person highlighted in the Chat Selection
window. If you are already chatting with the highlighted person, Alt+L
will bring that chat window to the foreground.

Alt+C Opens the dial pad so you can call the person highlighted in the Chat
Selection window. The Name: Number field is auto-populated with the
selected person's extension.

Ctrl+Shift+H Selects the chat log pane.

Ctrl+E Pastes Enterprise data of the current call into the text entry pane.

Sending a Chat Message

To send a chat message:
1. Click Chat on the toolbar to open the Chat Selection window.

2. Double-click the name of the person you want to chat with. A chat window opens and a chat session
begins with the person you selected.
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3. Type your message in the text entry pane and click Send or press Enter. Your message is sent to your
chat partner and logged in the chat history pane.

Note: If you want your message to be noticed immediately by popping on your chat partner’s
desktop, select the High priority check box.

Note: If you log out during a chat, your copy of the chat log is lost, the current Chat window
closes, and a new Chat window opens so you can continue communicating. The entire chat
log is still present in the other party’s Chat window.

To end a chat session:
n Choose File > Close or click Close in the upper right corner of the Chat window.

Sending Enterprise Data

You can use Chat to send the enterprise data associated with a call to another person.

To send enterprise data:
1. With a call active, open a chat session with the person you want to send enterprise data to.

2. Choose Actions > Paste Enterprise Data. The enterprise data from the active call is pasted into the
Chat window.

3. Click Send.
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Predefined High Priority Chat Messages

You might have a task button configured to send a high priority chat message to your supervisor. The text
of this chat message is predefined and set up by your administrator. An example of such a message is
“Please monitor my call.” It appears in a Chat window that pops up on your supervisor’s desktop.

These predefined messages behave just like a chat message you send that is tagged as a high priority
message.

Calling Someone in the Chat List

You can make a call, transfer a call, or conference a call to anyone listed in your Chat Selection window
using the call control actions.

n To call someone, you must be logged into Agent Desktop and be in an agent state that allows you to
make a call.

n You cannot call someone listed in your Personal Contacts drawer.

n You do not have to be chatting with an agent or SME in order to call them.

The call control menu items are typically disabled for SMEs. In order to make a call, transfer a call, or
conference a call to an SME in your chat list, the SME must be configured as an External Contact by your
administrator. If an SME name does not have a phone number associated with it, the call control menu
items are disabled.

To call someone in your chat list:

1. In the Chat Selection window, do one of the following:

n If you are chatting with the person you want to call, choose Actions > Call, Transfer, or Con-
ference.

n If you are not chatting with the person you want to call, select the person’s name and choose
Actions > Call, Transfer, or Conference. You can also right-click the person’s name and choose
the desired call action from the resulting popup menu.

The Make a Call dial pad appears with the person’s phone number autofilled in the Name: Number
field.

2. Click Dial.
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You can record calls if you are set up to do so by your administrator and if you are using the Enhanced or
Premium version of Agent Desktop. The administrator customizes your toolbar with two task buttons: one
button starts recording and the other button stops recording.

The default icons for customizable task buttons are green circles with numbers inside them. Using them on
the Agent Desktop toolbar is optional. Your administrator can choose to use other icons for the buttons
assigned to the recording function.

When you are recording a call, the icon next to the call information in the Call Activity pane changes from
the Talking icon to the Recording icon.

When recording a call, keep in mind the following:

n The recording starts when you are connected to a customer call and you click Start Recording.

n The recording ends automatically when the call terminates, or when you click Stop Recording,
whichever comes first.

n You cannot use the Stop Recording button to stop a recording that your supervisor started. If you do
click Stop Recording in this situation, the recording icon will disappear from the CAll Activity pane, but
the call will still be recorded until your supervisor stops it.

n Your supervisor can stop a recording that you started.

n Only your supervisor can play back recordings that you make.

n Recording in a multi-line environment depends on your configuration. You might not be able to record
non-ACD calls.
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Agent Real Time Displays
There are several real time displays (reports) you can view in the Agent Report window. These displays
are:

n Agent ACD State Log Display

n Agent Call Log Display

n Agent Detail Display

n Skills Statistics Display

You can sort displays by any of the columns in ascending or descending order by clicking on the column
header.

Note: The Agent Real Time Displays window is designed to always be on top of other open
windows. However, if the “Always on Top” window behavior mode is selected for the main Agent
Desktop window, it will override the Agent Real Time Displays behavior and the Agent Desktop
window will appear on top.

To view agent real time displays:
1. On the toolbar, click Real Time Displays. The Agent Real Time Displays window appears.

2. From the Real Time Displays drop-down list, select the display you want to view. The display appears.

3. Click Refresh (if enabled) to update the information.

Display Status

Every real-time display window has a status bar at the bottom. The status bar shows the current status of
the display, either Active or Inactive.

n Activemeans that the data in the display is current and being updated at specified refresh intervals.

n Inactivemeans that the data is not being updated because the service that generates it has failed and
new data is no longer being received.

If you click away from and then return to an inactive display or click the Refresh button, the display will be
blank. Once the service recovers, the latest data is shown in the display and the status is changed from
Inactive to Active.

All real-time displays are always available, regardless of whether the associated service is functioning or
not.
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Agent ACD State Log Display

The Agent ACD State Log Display shows a record of all ACD server state transitions for the current day,
starting at midnight. The report is in chronological order.

The display fields are described in the following table.

Field Description

Start Time The time the ACD agent state was initiated. Start time is based on the
time the Recording & Statistics server received the ACD agent state
data from Agent Desktop, so that the start time reflects the Recording
& Statistics server time, not the time shown on your PC. Note that if the
Recording & Statistics server and the agent PC are in different time
zones, this is taken into account so that start times display the correct
time zone.

Agent State your ACD agent state. The last ACD agent state written to the log is
actually the previous ACD state that you were in. In order to calculate
State Duration, the current state cannot be written to the log until you
transition to the next ACD agent state.

Wrap-up Data Any wrap-up data you entered, if the agent state you transition to is
Work Ready or Work Not Ready.

Reason Code A number followed by a string description in parentheses identifying
why the agent is in the current state. Displays 0 (zero) if there is no
reason code. This field only applies to the Not Ready and Logout
states.

State Duration The amount of time you spend in the agent state.

Agent Call Log Display

The Agent Call Log Display shows a record of calls made and received over the last seven days by day.

The display fields are described in the following table.

Field Description

Start Time Time the call started. Start time is based on the time the Recording &
Statistics service receives the state data from Agent Desktop, so that
the start time reflects the Recording & Statistics service server time,
not the time shown on your PC. Note that if the Recording & Statistics
service server and the agent PC are in different time zones, this is
taken into account.

Direction Inbound or outbound call.
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Field Description

Answered (Yes/No) Was the call answered?

Calling Party The number of the phone that made the call.

Called Party The number of the phone that received the call.

Call Duration The length of the call.

For inbound calls: call duration = ring time + talk time + hold time.

For outbound calls: call duration = dial tone + ringback + talk time +
hold time

ACD Line Indicates if the call came in on an ACD (Yes) or non-ACD (No) line.

Agent Detail Display

The Agent Detail Display shows your performance statistics for the current day. This information is
refreshed automatically every 10 seconds.

The display fields are described in the following table.

Field Description

Calls Presented Number of inbound calls (ACD or non-ACD) that are delivered to your
extension (causes your phone to ring). This can be verified by counting
the number of entries whose call direction displays “Inbound” in the
Agent Call Log for the current day.

Calls Handled Number of inbound calls (ACD or non-ACD) that are answered at your
extension. This can be verified by counting the number of entries
whose Call Answered column displays “Yes” in the Agent Call Log for
inbound calls only for the current day.

Avg Talking The total time on calls (all talk time + all hold time) divided by the num-
ber of calls.

Max Talking The length of the longest call (talk time + hold time)

Total Talking The total time on calls (all talk time + all hold time)

Avg Ready The total time spent in the Ready state divided by the number of times
spent in the Ready state.

Max Ready The longest time spent in the Ready state.

Total Ready The total time spent in the Ready state.
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Field Description

Avg Not Ready The total time spent in the Not Ready state divided by the number of
times spent in the Not Ready state.

Max Not Ready The longest time spent in the Not Ready state.

Total Not Ready The total time spent in the Not Ready state.

Avg After Call Work The total time spent in the Work state divided by the number of times
spent in the Work state.

Max After Call Work The longest time spent in the Work state.

Total After Call Work The total time spent in the Work state.

Skills Statistics Display

The Skills Statistics Display shows information about skill groups and the resources available to answer
calls that are routed to them. This information is refreshed every 30 seconds.

The display fields are described in the following table.

Field Description

Skill Name The name/ID of the skill group.

Due to the way ICMworks, an ICM-generated default skill group will be
displayed. The name of this skill group is usually a long string of
numbers (for example, 000919530508). No agents are assigned to this
skill group, and it can safely be ignored.

Agents Logged In Number of agents currently logged in to the skill group.

Calls Handled Number of inbound ACD calls handled by agents in the skill group.

Talk Average Average talk time for inbound ACD calls counted as handled by agents
in the skill group.

Calls Waiting Number of calls currently queued to the skill group.

Current Oldest Duration of the oldest call in the queue.
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Integrated Browser
The integrated browser feature is available in the CAD Premium package. The integrated browser allows
you to view intranet and internet web pages fromwithin Agent Desktop. Its behavior and features are
configured by your administrator. These configured features include the following:

n Popup windows can be displayed as a new tab or as a regular Internet Explorer popup window.

n The integrated browser can support up to 10 tabs. The first tab is reserved for web pages your super-
visor pushes to you in order to assist you in helping customers.

n Your administrator can configure specific web pages to display in each browser tab. If the admin-
istrator does not do this, the tab is blank.

n Your administrator might configure a specific web page to display in the browser pane as your home
page. If the administrator does not do this, the pane is blank except for the message, “The home page
is not configured in Desktop Administrator.”

n If set up to do so as part of a work flow, Agent Desktop can use call enterprise data to interact with a
web application (such as a customer database) and display customer information in the integrated
browser.

You can click Show/Hide Integrated Browser on the toolbar to show or hide this section of the Agent
Desktop window.

Note: The integrated browser supports only one web session at a time for web applications that
use cookies for session management. For example, you cannot log into a web application that
uses cookies in one tab as User A and then log into the same web application in another tab as
User B. However, multiple web sessions are supported for web applications that use URL-based
session management.

Note: Internet Explorer must be installed on your PC for the integrated browser to function
correctly. However, the integrated browser is not a version of Internet Explorer. While the
integrated browser and Internet Explorer share the underlying operating system’s browser engine,
there are many features that are part of Internet Explorer that are not available to the integrated
browser.

Integrated Browser Notes
n You must have a supported version of Internet Explorer on your PC for the integrated browser to func-

tion.

n The Internet Explorer tabbed browsing feature is not available in the integrated browser.

n The integrated browser supports only one web session at a time for web applications that use cookies
for session management. For example, you cannot log into a web application that uses cookies in one
tab as User A and then log into the same web application in another tab as User B. However, multiple
web sessions are supported for web applications that use URL-based session management.
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n Reordering integrated browser tabs by dragging is not supported.

n Web pages displayed in the integrated browser that take a long time to load completely can have an
affect on Agent Desktop performance, for example, slowing the scrolling of teammessages.

Toolbar Buttons and Shortcut Keys

The integrated browser toolbar contains basic browser buttons that allow you to navigate among the web
pages you view, refresh a current page, and return to your home page.

The integrated browser toolbar buttons and shortcut keys are listed in the following table.

Button Name Shortcut Description

Back Alt+left arrow Returns you to the last page you
viewed.

Forward Alt+right arrow Takes you to the page you viewed
before clicking the Back button.

Stop Esc Stops the browser from loading a web
page.

Refresh F5 Refreshes the current web page.

Home Alt+Home Returns you to your predefined home
page.

— New Tab Ctrl+Shift+T Opens a new tab.

— New Window Ctrl+N Opens a new window (if enabled by
your administrator) or opens a new
tab.

— Next Tab Ctrl+Shift+Tab Takes you to the next tab.

— Address Alt+D Selects the Address field (if configured
to be visible).

— Browser Ctrl+Shift+B Selects the browser pane.

— Toolbar Alt+I Selects the browser toolbar.

— Work Sites Alt+W Selects the Work Sites field.
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Button Name Shortcut Description

— Specified Tab Ctrl+Shift+<tab
number>

Takes you to the specified tab, where
0 is the first tab, 1 is the next tab, and
so on.

— — Shift+click Opens a link in a new window.

— — Ctrl+click or
middle mouse but-
ton

Opens a link in a new tab in the back-
ground.

— — Ctrl+Shift+click Opens a link in a new tab in the fore-
ground.

AccessingWork Sites

The administrator can set up a list of frequently used websites. These “favorites” appear in the Work Sites
drop-down list. You can select a website from this list to access it quickly, without having to type in its
web address.

Accessing OtherWebsites

The administrator can configure the browser to include the optional Address field. This enables you to
access a website that is not listed in the Work Sites drop-down list.

Note: The first tab, which is reserved for web pages the supervisor pushes to you, never has an
Address field on it. The Address field appears only on the other tabs.

If you access a website that uses popup windows, those popups will create new browser tabs. You can
add up to 15 browser tabs for these popup windows even though the integrated browser is limited to a
maximum of 10 tabs.

The popup window browser tabs can be closed by clicking the Close button in the upper right corner of the
tab. If you access enough popup windows to exceed the maximum of 15, the additional popups will use
the default browser.

To access a website using the Address field:
n Enter the website’s address (URL) in the Address field, and then press Enter.

Dialing Hyperlinked Phone Numbers

If enabled by the administrator, you can dial a phone number displayed as a hyperlink on a web page by
clicking it.
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n The phone number must be 10 digits long and use the North American dial plan format:

<3-digit area code> <3-digit exchange> <4-digit subscriber number>

Shorter numbers, such as local numbers without area codes or phone extensions, cannot be dialed.

n You can dial a hyperlinked phone number only if you are in the Not Ready agent state.

n The phone number can have parentheses around the area code, and use any combination of spaces,
hyphens, and periods in the phone number.

n Phone numbers that are actually image files or are populated from databases cannot be dialed.

n Some web sites hide hyperlinks; the phone number might not look like it is hyperlinked, but it actually
is and can be dialed.

n The phone number cannot contain alpha characters. For instance, the phone number 555-GET-PZZA
cannot be dialed.

n A dialed hyperlinked phone number will not appear in the Recent Call List in the Dial Pad window.

n The phone number hyperlinks disappear if you refresh the site by right-clicking and choosing the
Refresh menu option. To refresh the page without losing the hyperlinks, press F5 or click Refresh on
the integrated browser toolbar.

69



Reason Codes
Agent Desktop can be configured by the administrator so that you are required to enter reason codes.

Reason codes describe why you have transitioned to the Not Ready or Logout agent state. These codes
are set up by your administrator and are customized for your contact center.

Whenever you initiate a transition to the Not Ready or Logout state, or such a transition is included in a
work flow, a popup dialog box appears. You must select the one appropriate code from that dialog box and
click OK in order to make the transition.

You can click the Not Ready button again when you are already in the Not Ready state. This enables you
to enter another reason code. Reports will show back-to-back Not Ready state changes with the
appropriate times in state and the respective reason codes. However, if you choose the same reason code
again, a new state change is not recorded.

There are several situations in which you will not see the Reason Code dialog box:

n Your supervisor initiates the transition (a reason code indicating that the supervisor forced the agent
state change is automatically selected).

n Your agent state is changed automatically from Ready to Not Ready when an ACD call is routed to
your phone but you do not answer it, and it is rerouted to another agent (Reroute on No Answer, or
RONA).
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n Your agent state is changed automatically from Ready to Not Ready when you receive a non-ACD
call.

n The agent state change is part of a work flow in which automated reason codes are enabled.
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Wrap-up Data
Agent Desktop can be configured by the administrator so that you are required to enter wrap-up data.

Contact centers use wrap-up data for many reasons, such as tracking the frequency of different activities
or identifying the account to which to charge a call. Like reason codes, wrap-up data descriptions are set
up by your administrator to reflect the needs of your contact center.

If you are required to use wrap-up data, whenever your state changes to Work Ready or Work Not Ready
immediately after you end a call (you clicked the Work Ready or Work Not Ready button during the call),
the Select Call Wrap-up dialog box appears. Select the appropriate description from the dialog box and
click OK or press Enter to complete the transition.

If desired, you can sort the descriptions by clicking the column header.
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Service Autorecovery
The service autorecovery feature allows Agent Desktop to automatically recover its connection to the CAD
services in the event of a service restart or a network outage.

Note: In some situations, you will not recover your connection to Cisco Unified Presence and you
must log back into Unified Presence manually.

If you log back in within 20 minutes after service recovery using the same login name/ID and password,
your state will automatically be the same as the state you were in when the service or network connection
failed.

Note: You are not notified when you log in about any inactive services. You are notified if a
service stops after you log in.

When Agent Desktop detects that it is unable to communicate with a service (generally within three
minutes of the service failure), the status bar displays “Partial Service” or “No Service” to indicate some or
all of the services have failed.

When Agent Desktop detects that the service is again available (usually within one minute of service
recovery), the status bar displays “In Service” to indicate the services have recovered.

Note: When Unified Communications Manager (Unified CM) fails, you are logged out. You must
log back in manually after Unified CM recovers.

Service StatusWindow

To learn more about the features that are affected by a service failure, double-click the status message on
the status bar. Agent Desktop displays a popup box that lists Agent Desktop features and indicates if that
feature is available or not due to the service outage.
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Note: The Service Status window displays a snapshot only. To see the most current status, close
and then reopen the window.

Loss of BIPPA Service

Non-Redundant Systems

If you lose your connection to the Browser and IP Phone Agent (BIPPA) service, Agent Desktop continually
tries to reconnect. When Agent Desktop is successfully reconnected to the BIPPA service, the system
prompts you to log in again.

Redundant Systems

If you lose your connection to one BIPPA service in a redundant system, Agent Desktop attempts to
connect to an active BIPPA service until a connection is made. At that time the system prompts you to log
in again.

If you are unable to connect to a BIPPA service on your initial login, you receive an error message that the
service is unavailable and Agent Desktop closes. In this case, you must manually redirect your browser to
the redundant BIPPA service and log in to that service as usual.

Loss of CTI Service

If the CTI service stops running, but all of the other CAD services are still running, you will not be able to
log in. You will be prompted to try logging in again until you are successful. If you are on a call when the
CTI service stops running, the call is dropped.
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Loss of LDAP Service

If the LDAP service is not running when you try to log in, your login will not be successful. If the LDAP
service stops running while you are logged in, your session will not be affected.

Loss of LRM Service

If the LRM service is not running when you try to log in, your login will not be successful. If the LRM service
stops running while you are logged in, your session will not be affected.

Loss of Other Services

If other CAD services go down while you are logged in, you might lose some functionality but you will not
be logged out.
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